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Introduction:  
 
In this tutorial, a solid finite element model of a plate with central hole is created. The 
loading is in the plane of the plate and the deformation is small enough to warrant a linear 
elastic analysis. 
 
NOTE: It is assumed that you have basic familiarity with CAD modeling in 
3DEXPERIENCE allowing you to create a block with a central hole. If that is not the 
case, please consult the following tutorial book. 
 
CAD Modeling Essentials in 3DEXPERIENCE, by Nader Zamani, SDC Publications, 
ISBN 978-1-63057-095-8. 
 
 
Problem Statement: 
 
The steel plate shown below is subjected to a pressure load P at the two ends. Although 
the problem has three planes of symmetry, you will be modeling the full geometry. The 
loading is assumed to be small enough to cause a linear elastic behavior.  
 
 
 
 
 
 
 
 
 
 
 
 

The dimensions of the part to be analyzed are such that the parameter 
H
Dr = is 0.25. The 

chart below gives a stress concentration factor of 4.2=tK . This chart is based on 
HL >> which is not true in the modeled block. However, the value of tK  will be used 

for comparative purposes. 
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There are many types of solid elements available in the software; however, in this 
chapter, tetrahedron elements are used. They come in linear and parabolic forms. Both 
are referred to as tetrahedron elements and shown below. 
                                 

 
The linear tetrahedron elements are faster computationally but less accurate. On the other 
hand, the parabolic elements require more computational resources but lead to more 
accurate results. Another important feature of parabolic elements is that they can fit 
curved surfaces better. In general, the analysis of bulky objects requires the use of solid 
elements. 
 
 
In a solid continuum, the state of deformation is described by the six components of the 
Cauchy stress{ }yzxzxyzyx ,,,,, τττσσσ  which vary from point to point. The von Mises 
stress is a combination of these according to the following expression: 
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For an obvious reason, this is also known as the effective stress. Note that by definition, 
the von Mises stress is always a positive number.  In terms of principal stresses, VMσ  can 
also be written as 
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For many ductile materials, the onset of yielding (permanent plastic deformation) takes 
place when YVM σ=σ where Yσ is the yield strength of the material. For design purposes, 

a factor of safety “N” is introduced leading to the condition
N

Y
VM

σ
=σ . 

Therefore, a safe design is one where
N

Y
VM

σ
<σ .  The von Mises stress contour plot 

allows you to check the above condition. 

 

Tetrahedron Elements

linear parabolic

Tetrahedron Elements

linear parabolic
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The Model and Material Properties: 
 

First, using the Part Design App , create a block with a central hole with the 
dimensions L = 0.15m, H= 0.1m, W = 0.02m, and D = 0.025m as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 

 
The first task is to apply a 
material property to this 
part. From the bottom row 
of icons (i.e. the action bar), 
select the “Tools” tab. 
 
From the Tools menu, select the dropdown to the right of the “Material Browser” icon 

. This opens up the section menu as shown. Follow the steps outlined below to select 

the “Create Material” . 
  

The selection of  opens up a dialogue box shown on the next page. This box allows 
you to supply a proper name for the material should you decide to do so. Our assumption 

 

 

Select the “Tools” tab
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is that you do not have a material of interest in the “cloud” database and would like to 
follow the steps to create it. It is a rather tedious process but will be clearly spelled out. 
 
 

Select the “Create Material”  icon. Make sure that you check “Add domain” section 
of the dialogue box, and that the “Simulation Domain” is picked. Note that this creates a 
shell (a placeholder)  and the material information needs to be supplied later. 
 

 
 
 
 
Once you close the dialogue 
box by clicking on “OK”, you 
will find yourself in the 
material database and can 
identify the material that you 
just created, namely 
“Steel_FEA_CH2”. The 
database screen is shown on 
the right. 
 
 
 
Place the cursor on your 
created material in the 
database, right click and 
select “Apply”. You still 
have to return to the screen 
where the geometry exists 
and continue. This 
necessitates the closure of 
the current screen (the 
database screen). 

 

Type your desired name

 

Make sure that the
“Simulation Domain”
is checked

 

Here is the material property that you created.
This is just a “shell”, information needs to be inputted later.

 

Position the cursor here on the screen, right click, select “Apply”
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Select the “X “on the top 
right margin of the 
database screen to close 
the window.  
 
You will return to the 
geometry window; 
however, the shape of 
the cursor is modified as 
shown below. 

 
 
 

Place the cursor on the part on 
the screen or on the top branch 
of the tree and double click. 
 
You will notice that the 
“Materials” branch is created at 
the very bottom of the tree as 
shown below. You can then 
use the cursor to select the 
“Green” check mark to 
proceed. 
   
 
 
 
 
 
 
 
 
 
 
Please note that the actual material 
properties are yet to be inputted. 
Expanding the “Materials” branch 
reveals two other branches. The 
location where the properties are 
inputted is the last branch “Material 
Simulation Domain00004139” as 
shown on the right. 

 

Close this window by clicking on “ X ”.
Be careful not close the App. instead.

 

 

 

Select the “Green”
check mark from
this box

The created material has been assigned but this is just a “shell” , information needs to be inputted later.

 
Input material properties by double clicking on this branch

Close this window by clicking on “X”. 
Be careful not to close the App. instead.  
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Double click on the last branch and follow the steps below. 
 

 
Steps: 
1. Expand the Structures Option 
2. Continue Expanding until the Elastic 
Option is visible 
3. Click on the Elastic Option & input 
the Young’s modulus and Poisson 
Ratio. 
 

 
 
 
 
 
 
 

In Step 3, the Young’s modulus and Poisson ratio can be inputted. For the present 
problem, 𝐸𝐸 = 2 ∗ 1011 𝑃𝑃𝑃𝑃 and 𝜈𝜈 = 0.3, which are the standard values for carbon steel. 
Properties can be changed by simply double clicking on the last branch shown. 
 
 
 
 
 
 

 
Step 1 

 

 
Step 2 

 

 

 
Step 3 
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Creating an Abstraction Shape: 
 
When performing a structural analysis, one often simplifies the model. These 
simplifications may include modeling a symmetric portion of a component, removing 
small non-critical features, or even modeling a solid component as a shell. Modifying the 
3D Shape used for designing and manufacturing the component could cause costly errors. 
Fortunately, 3DEXPERIENCE provides a feature called an “Abstraction Shape”. The 
Abstraction Shape provides a container with a dependent copy of the design 3D Shape. 
 

 
 
Inserting an Abstraction Shape is a straightforward process. As shown below, right click 
on the part, select Insert, and then select Abstraction Shape. 
 

 
Step 1    Step 2    Step 3 
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Creating a dependent copy of the 3D Shape, used for the design and manufacturing, and 
placing it in the Abstraction Shape requires a bit more effort. To accomplish this task: 

1. Double click on the 3D Shape to activate it 
2. Right click on the PartBody associated with the 3D Shape 
3. Select Copy 
4. Double click on the Abstraction Shape to activate it 
5. Right click on the PartBody associated with the Abstraction Shape 
6. Select Paste Special 
7. Select “As Result With Link” and then click on OK. 

 
 

 

Step 1 Step 2 Step 3

Step 4 Step 5 Step 6

Step 7
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For most simulations, we could leave the model as it is. But some of the functionality 
used by the simulation apps requires the solid to be located under the PartBody. 
Therefore, we perform the following three steps to clean up the model. 

1. Drag and drop the solid to the PartBody 
2. Right click on the now empty body container 
3. Select delete 

The steps to clean up the model and the final model tree are depicted below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

drag & 
drop

Step 1 Step 2

Step 3 Final
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Creating the Finite Element Model: 
 
Click on the compass at the top left corner of 
the screen. Be sure that the “ME” and “As a 
System of Operations” choices are active as 
depicted in the figure to the right. If you have 
difficulty locating any app, you can activate the 
search capability by clicking on the magnifying 
glass. You can also drag any app into your “My 
Favorite Apps” for easy access in the future. 
Scroll through the applications and select the 

“Structural Model Creation” App . 
 
 
 
 
 
The “Create Finite Element Model” dialogue box appears. For now, select the 
“Automatic” option for the Initialization Method. The other initialization methods 
provide a user with additional control over the meshing process. The selection of 
“Automatic” creates parabolic tetrahedral elements.  Next, activate the geometry 
selection and click on the PartBody under the Abstraction Shape. Then click on OK.

 
 
The row of icons at the bottom of your screen (action bar) changes and will appear 
similar to the one displayed below. 
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The tree indicates that a mesh 
and the corresponding solid 
section has been created. 
 
 
 

 
Expanding the branch “Finite Element 
Model0003095” further indicates that the 
elements are of “Tetrahedron” type and the 
property is “Solid Section” as expected. 
 
Upon double clicking on the “Tetrahedron 
Mesh.1” branch, the corresponding dialogue box shown 
on the right pops up. Here, one can change the type (linear 
or quadratic), the size and sag, and certain other 
parameters. For example, local mesh refinement can be 
accomplished through the “Local Specifications”. Click 
on “Initialize from geometry” and then click on OK. 
 
There are different methods for displaying the mesh. 
The instructions given below are one method of achieving 
that objective. 
 

From the bottom row of icons, select the “Mesh” icon . 
 
 
The bottom row’s appearance now looks similar to below. 

 
 
 
 

 
Select the “Update” icon

.  
Upon updating, the mesh 
appears on the screen as shown 
on the right.  
 
 
 
 

 

Mesh and Properties are created
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There are also different ways of 
hiding the mesh. For example, first 
select the “Display” tab from the 
bottom row of icons. 
 
 

you can select the “Visualization Management” icon  from the 
choices. The resulting dialogue box shown on the right appears. 
You can then use the dropdowns to show or hide the various 
features. 
 
 
There are a few other icons that are worth mentioning here.  

Selecting the “Sectioning” icon  cuts the 
mesh with the standard xy, xz, and yz planes as 
shown. 
 
 
 
 

The “Clipping Box” icon  enables you to select a region of your mesh. 
 
 
 
 
 
 
 
 
 
 
 
 
There are several other mesh visualization tools available including changing element 
color and shrinking the elements. We do not discuss those further but will highlight the 
mesh “Mesh Visualization Quality” plot. This allows one to quickly identify poor quality 
elements that could produce erroneous results. 
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Creating a Scenario: 
 
The nature of the analysis, namely Static, Dynamic, Buckling, etc., is set in the 
“Structural Scenario Creation” App. Furthermore, the loads, restraints, and interaction are 
also defined in this application. 
 
It is also important to point out that that one could have created the Scenario before the 
“Finite Element Model Creation” step. In fact, the latter can be created from within the 
“Structural Scenario Creation” App. 
 
Click on the compass in the top left corner of 
the screen as shown here. Scroll through the 
applications and select the “Structural Scenario  
 
 
 
 
 
 
Creation” App.  
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The pop-up window “Simulation Initialization” shown below appears on the screen. 
Since this is strictly a structural problem, the radio button “Structural” should be selected. 
A quick glance of the tree confirms that a “Scenario” has been created. 
 

 
 
 
 
 
 
 
 
 
The row of icons at the bottom of your screen changes and will resemble the one 
displayed below.  

 
Checking the middle bottom section of the 
screen reveals that there are two red 
exclamation signs.  
These pertain to “Structural Analysis Case.1” 
and “No Procedures Exist”. 
 
 
 
From the “Setup” tab, click the “Finite Element Model” 

icon . The following pop-up window displayed on 
the next page appears. 
 

 

Scenario created

 

Red exclamation signs
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Since there is already a finite element model 
created, it appears in the list. Be sure that you 
select that row. Notice that there is also an 
option to create a finite element model. As 
mentioned earlier, the FE model can also be 
created within the Scenario, and this is where 
you would complete that task. In this case, it 
does not apply because an FE model was 
already created and selected. 
 
Select the “Procedures” tab from the action bar (bottom row). 

 
 
 
 
 
 

Select the “Static Step” icon  from the bottom row. 
 
 
 
 
 
 
The “Static Step” dialogue box pops up. Accept all the defaults. Note that if the  
“Advanced” pulldown list is selected, it becomes clear that this is the point in the 
software where “Geometric Nonlinearities” are included, or excluded. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Select this row

 

Procedures tab

 

 

NLGEOM
Included
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A quick glance at the 
bottom middle section of 
the screen reveals “Green” 
checkmarks instead of 
“Red” exclamation marks. 
 
 
The tree indicates that “Static Step.1” has 
been created. There are default basic 
output entities that are requested upon the 
creation of a Step. 
 
 
 
 
 
Accessing the Model, Scenario and Results Quickly: 
 
Clearly this can be done by double clicking on the corresponding branches of the tree. 
However, it can also be done efficiently by selecting the appropriate icon among these 

three: . The first one on the left is “Model and Mesh”, the middle 
one is “Scenario” and the one on the far right is “Results”; that is the postprocessor. 
 
 
Applying the Pressure Load: 
 
A pressure load of -100000 Pa is to be applied on the end faces. Note that positive 
pressure by convention is a compressive load. Since the notched block is under tension, 
pressure value is inputted as a negative number. 

 
 
 
 

 
 
Select the two end faces of the block; keep in 
mind the multiple selection is done with 
holding the Ctrl key down. 
 

Select the “Pressure” icon  from the 
bottom row of icons and input the pressure 
value. 

 

Note the “Green” checkmarks instead of “Red” exclamations 

 

 

Select the “Loads” tab

 

Select these two faces
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Applying the Restraints: 
 
The problem under consideration is in static equilibrium without imposing any restraints. 
However, due to the geometrical and loading symmetries, it possesses three planes of 
symmetry. Therefore, in principle, one needs to model 1/8th of the geometry only. 
 
In the present model, no symmetry 
considerations will be made. Since the 
structure can move as a rigid body and still 
remain under equilibrium, the so called {1,2,3} 
rule will be imposed. This is illustrated in the 
figure on the right. The arrows represent a zero 
displacement in the shown direction.     
 
The (1,2,3) restraint representing (x,y,z) 
prevents the block from flying away. The (1,2) 
restraint representing (x,y) prevents rotation 
about the x and y axis. Finally, the (3) restraint representing (z) eliminates the rotation 
about the z axis. 
 
Select the “Restraints” tab from the bottom toolbar (the action bar). 

 
 
 
 
 
 
 

Choose the “Fixed Displacement” icon  
followed by the bottom vertex as shown. 
 
In the dialogue box, check all three 
“Translations”. 
 
 
 

 

 
X Y

Z

(1,2)

(1,2,3)

(1)

 

Restraints tab

 

This
vertex
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Repeat the same process for the other two vertices and choose the appropriate translations 
as shown. 

  
As a side comment, instead of using the 

“Fixed Displacement” icon  and 
checking all three x,y,z translations, one 

could have used the “Clamp” icon . 
 
 
Note that the imposed restraints are now 
reflected in the tree. 
 
 
 
 
 
 
 
 
Consistency, Model Check, and Simulation: 
 
Select the “Simulation” tab from the bottom row of icons on your screen 

 
 
 
 
 
 
 

Select the “Results Storage” icon  from the bottom row to define where the 
simulation results will be stored. While model and scenario data is always stored on the 
server, simulation results may either be stored on the server or on the local machine. If 
the “Local” option is selected, the results will be stored in 
C:\Users\WinUsername\AppData\Local\DassaultSystemes\PLM_LocalResult. 

 

This
vertex

 

 

Restraints
Applied

 

Simulate tab
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However, the data is masked, encrypted, and only accessible by the owner of the data. 
Students should check with their instructor to determine the proper location for storing 
their simulation results. For this case, we select the “Server” radio button. 
 
 
 
 
 
 
 
 
 
It is a good practice to perform the consistency and 
consistency check before submitting the work for the final 
run. 
Select the “Model and Scenario Check” icon from the 

bottom row . 
The software goes through a check phase and if there are no issues, a message with a 
“Green” check mark is returned. 

 
 
 
 
 
 
 
 

Next select the “Simulation Checks” icon  from the bottom row 
of icons. Accept the number of “Cores” in the pop up box below. 
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Upon the completion of the “Simulation Check”, any errors or warning messages will be 
available in the pop up box below. 
 
 
 
 
 
 
 

Assuming that there are no serious issues (i.e. no error messages), you are ready to 
submit the job for “Simulation”. 

Select the “Simulation” icon  from the bottom row. 
Accept the number of “cores” in the pop up box, and wait for the simulation to complete. 
 

 
 
 
 
 
 
 
 
 
 

 
During this phase “Simulation 
Status”, important messages such as 
“Licenses”, “Plots”, and “Iterations” 
are recorded in the main pop-up 
window. These can be viewed by 
selecting the appropriate tab. 
 
 
 
In the present run, if you select the 
“Iterations” tab you will see a single 
iteration as the problem in linear. 
 
 

 

 

 

Successfully completed
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The “Plots” tab reveals nothing 
interesting. The problem being linear, 
there is only one iteration to get the 
solution. 
 
 
 
 
From the “Feature Manager” dropdown, select the “Diagnostic 

Viewer”  from the menu. This can also be launched by typing 
Alt+v. 
 
Once the window pops up, click on the arrows to expand the 
records. 

 
 
Under the 
“Advanced” section, 
use the pulldown 
menu to expand the 
choices. Here, you 
can select an item of 
interest to get 
information about. 
 
 
For example, if you are seeking information about “Iterations”, make that selection and 
click on “Status”. A text file (Notepad) is generated which pertains to the requested item. 
 

 

 

 

Click to
Expand
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Results (Post processing): 
 
Once you close (or move) the 
obstructing dialogue boxes, you must 
be in the “Results” section and the 
bottom row should appear as shown on 
the right.  
 

If not, click on the “Results” icon . 
 
In the background, you  
should see the “Plots” 
dialogue box which shows 
the results of Frame1, and 
the initial results and the 
results after the first 
iteration. If the first of the 
“Plots” dialogue box is 
highlighted, the value of 
the von Mises stress is 
zero as shown on the right.  
 
 

 

Select the  Item that you want a report on

Select the  type of report you are seeking

 

 

 

 



2-24  Linear Elastic Analysis of a Notched Plate 

This is not surprising as the first row is before any incremental load is applied. If the load 
is zero, the displacement and stress are both zero. Use the cursor to select the second row 
of the “Plots” dialogue box. One can then see the von Mises stress distribution in the part. 
 
The stress concentration graph 
given on page 2-1 indicates a 
factor of 2.4 for the given 
dimensions. Since the 
magnitude of the applied 
pressure was 1.00E+5 Pa, a 
maximum von Mises stress of 
3.19E+5 Pa is in reasonable 
agreement with theory. Keep in 
mind that this is a coarse grid. 
 
In order to display the 
“Displacement.1”, use the “Plot” 
pulldown menu in this window 
and select “Displacement.1” as 
shown below. 
 
The “Plots” dialogue box 
can be closed to make 
room on the screen if 
needed. Use the cursor and 
select the arrow on the top 
left corner of the window; 
this will collapse the box 
as seen next. 

 
 
 
 
 
 

 

 

Select 
Displacement.1
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Every time a new plot is to 
be generated, the previous 
one is deactivated. 
Checking the status of the 
tree on the right indicates 
that the “Displacement” is 
“Active”, whereas the other 
5 (including von Mises) are 
“Not Active”. 
 
 
Plots which are “Not Active” have a marker  next to them. There may be good reasons 
that you want several plots on the screen side by side. Suppose that you want the contour 
plots of the displacement and the von Mises stress side by side. 
 
Select the “Display” tab from the bottom row of icons. 

 
 

Select the “Compare Results” icon  from the bottom row. 
 
 
The “Compare Results” dialog will appear as shown below. Click on the X’s to remove 
the two right panes. 
 

 

Activated
Not Activated

Not Activated

Not Activated
Not Activated

Not Activated

 

Select the Display  Tab
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Then, drag and drop the displacement field plot into the remaining lower pane. 
 

You will see that the von Mises Stress is displayed in the top sector of the screen and the 
displacement is displayed in the bottom sector of the screen as shown below. 
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An important skill in post processing is the ability to pan, zoom in and zoom out 
of the contour legend. In order to explain the process, plot the contour of 
“Displacement.1”. Point the cursor to the contour legend and select it (left click). You 
will see that the contour plot (on the block) becomes dim. This is an indication that the 
contour plot is “Not Active”, whereas the contour legend is. Now, selecting the legend 
with the middle mouse button down, the legend can be panned. Selecting the contour 
legend, a single click of the middle mouse button, and forward/backward motion of the 
mouse enables you to zoom in and zoom out of the legend. Once you are done, select the 
contour legend again which will activate the contour plot. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

Selecting the 
contour legend
dims out the
contour plot

Dimmed contour
plot

Select the contour legend, 
then zoom in, zoom out,
pan the contour as needed.
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The group of icons  on the bottom of screen are very 

useful in post processing. The compare results icon  has already been discussed. We 
will now review the plot sectioning icon . Once this icon is selected, the part can be 
cut at an arbitrary orientation by rotating/translating the “Robot”; two random cuts are 
shown below. 

 
Manipulating the contour 
plots as far as formatting 
and setting the parameters 
is very important. To 
explore such features, 
double click on an existing 
contour on the screen (or 
simply double click on a 
branch of the tree which 
corresponds to a contour in 
the “Results” section). 
 
 
Once the contour appears on the screen, 
double click on it again. This action leads to 
the “Contour Plot” pop up window shown 
on the right. This window has three tabs and 
many pulldown menus which enables you to 
customize the plot. 
 
The three tabs are immediately below the 

“Name” . 
 
In the first tab, one can select the different 
variables to be plotted. 
 
 

 

 

Double click on
one of these 
branches or on
an existing contour
on your screen
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Selecting the middle tab  leads to the screen 
which enables you to change the “Scale factor”. 
By default, the scale factor is “1”. Change the 
“Scale factor” to “90000” and press the “Apply” 
button in the pop up window. 
 
 
 
 
 
 
 
 

Next select the third tab . 
 
 
This tab has an important section on “Edges”. 
The “Visible edges” pull down list gives you 

three options . 
 
The effects are shown in the contour plots 
below. 
 
 

 
Looking at the above contour plots one notices that there are no distinct color separation 
borders. It could be that for certain reasons, having a smooth transition between colors is 
not desirable. This can easily be changed by double clicking on the contour legends 
which will open the “Legend Options” dialogue box. The box is shown on the next page 
and gives you many other options regarding the contour. 

 

Scale factor of
90000 instead of 1

 

 

Visible edges = Mesh Visible edges = Outline Visible edges = None
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The number of colors, the maximum and minimum range for the variable can also be set 
in this window. Note that the setting which allows you to orient the legend “Horizontal” 
or “Vertical” is at the bottom of the window. 

Select the “Create Report” icon  from the bottom of the 
screen. This will lead to the dialogue box shown below. 

 
 
 
A professional looking report in “Word” or “PowerPoint” 
formats can be generated. Personalized information such as 
company/university logo can be automatically inserted.  
 
 

 
The results animation tool is located on the 
“Standard” tab. It is good practice to pin the 
“Standard” tab to the Action Bar. To do this, 
right click on the tab and select “Pin Section” as 
shown on the right. 
 

Select the “Play Animation” icon  from the bottom row. 
 
This loads the animation player as shown below. 

 
 
You can change the animation properties and save the animation by clicking on the 

“Animation Options” icon . 

 

Smooth
checked Smooth

Un-checked
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This loads the “Animation Options” dialog as 
shown on the right. Finally, looping control is 

achieved by clicking on the  icon. You can 
click through the options: loop, bounce, and 
one shot. 
 
A very useful post-processing feature is the “Show Min/Max 

Values” icon  from the bottom row of icons. 
 
 

 
Up until this point, the post processing dealt with contour plot fully rendered. The next 
activity deals with generating plots which are “symbol” based; for example, the y- 
component of the displacement vector (or symbol) but plotted as a vector. In this 
example, y is the direction where the part is loaded.  
 

Select the “Symbol Plot” icon  from the “Plots” tab at the 
bottom of the screen. Note that the icon “Isocontour Plot” is 

essentially the same as “Create Contour Plot” , except 
that there is no rendering. 

 

 

 

Do not show Max/Min Show only Max value

Show only Min value Show Max and Min values
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Follow the instructions below to select “UT, Translation” with “Vector Component 2”. 

 
For Symbol shape, select “Vectors” 
 

 
Finally press “Apply”. The symbol plot (vector plot) shown below appears. The issue 
with this plot is that there are too many symbols (arrows). 
 

 

 

Select the UT,
Translation as the
variable

Select the appropriate
component. Here it is
Component 2.

 

For Symbol shape
Select “Vectors”
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Follow the instructions given below in the middle tab of this window  to 
reduce the arrow density. 

 
 
 
 
The final activity is to explore the “Feature Manager” in the 
context of the simulation results. This selection leads to the 
“Feature Manager” dialogue box below which contains valuable 
information. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Slide the bar to reduce symbol (vector) density
When satisfied, press “Apply”
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It is worth mentioning that dialogue boxes such as “Feature Manager” and the 

“Diagnostic Viewer”  can be accessed any time by right clicking on the screen as 
shown below. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
There are many, many other important features that were not touched upon in this chapter 
but will be explored in later ones. 
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Exercise 1: Analysis of a Foot Pedal 
 
The foot pedal shown below is made of steel with Young’s modulus 30E+6 psi and 
Poisson ratio 0.3. The pedal is loaded with a normal force of 100 lb along the edge 
shown. The other end of the pedal is clamped. The geometrical dimensions are provided 
at the bottom of the page where all the dimensions are in inches. 
 

       
      
Try running the model with the two different element “size” and “sag” with both the 
linear and parabolic type of elements. Record the results in terms of the maximum 
displacement and the maximum von Mises stress in a table and comment on the results. 
The run time of the parabolic elements with element size of 0.1 could be substantial 
depending on the type of processor used.  
 
Partial Answer: 
 
 

Size = .3, sag = .05 
Element Type Linear Parabolic 

Maximum 
Displacement 

.0158 in. .0227 in. 

Maximum  
von Mises 

Stress 

 
5.32E+3 psi 

 
1.1E+4 psi 

 
 
 
 
 
 

 

  



2-36  Linear Elastic Analysis of a Notched Plate 

Size = .1, sag = .05 
Element Type Linear Parabolic 

Maximum 
Displacement 

.021 in. .0229 in. 

Maximum  
von Mises 

Stress 

 
9.43E+4 psi 

 
1.6E+4 psi 

 
 
The above tables reveal an extremely important fact about finite element analysis. 
Making a single run and accepting the results at face value is a serious mistake. Note that 
for linear elements as the mesh is refined, there is a significant change in both 
displacement and von Mises stress. The user should not accept either value as being 
correct and must refine the mesh further. The refinement should reach a point at which 
the difference with the previous mesh is not deemed to be significant to the user. This 
process is referred to as a mesh convergence study.   
Keep in mind that the refinement need not be uniform throughout the part. One should 
perform the refinement in the critical areas only. It is clear that parabolic elements are 
superior in accuracy to linear elements. Furthermore, note that although the displacement 
seems to have stabilized, the von Mises is still unreliable. It is well known that the 
displacements in FEA are more accurate than stresses. The reason is that the stresses are 
obtained by differentiating the displacement, a process which magnifies the error.  
 
 
Exercise 2: Analysis of a Cylindrical Bar under Torsion  
 
The cylindrical bar shown below has a clamped end. The other end is subjected to a 
couple caused by opposite forces on magnitude 1000 lbf separated by 1.5 in. This is 
equivalent to a torque of 1500 lbf.in applied to the cylinder. The material is steel with 
Young’s modulus 30E+6 and Poisson ratio of 0.3.    
The diameter of the cylinder is 1 in. and the dimensions of the loaded end are shown 
below. Although not showing, the length of the padded cylinder is 5 in. and the length of 
the padded rectangle is 0.5 in. All sharp corners at the loaded end have surface fillet of 
radius 0.1 in.  
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Model the part with linear solid elements with size = 0.1 and sag = 0.025 which results in 
the mesh shown in the previous page. Compare the hoop stress (The hoop stress is the 
largest principal stress “C11”) with the theoretical solution from strength of materials. 
 
Partial Answer: 
 
The strength of materials solution is based on 

J
Tr

=τ  where T is the applied torque, r is 

the radius of the cylinder and J is the polar moment of inertia. In terms of the diameter, 

2
Dr = , and 

32
DJ

4π
=  . The hoop stress “C1” which numerically equals τ  is calculated 

from 
3D

T16
π

. For the present problem, 1500T =  lb.in and 1D = in. Based on these 

parameters, a value of 7643 psi for the hoop stress is predicted.  
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Notes:  
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